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__________________________________________________________________________

1 Introduction
__________________________________________________________________________

Compact Pro™ is a Macintosh application which lets you reduce the size of many 
of the files on your computer by “compressing” the data in the files. Making files 
smaller can free up valuable space on your hard disk. It can also reduce the number 
of floppy disks needed to save back-up copies of important files. If you transfer 
files between computers using modems, you can save time and money by first 
compressing the files since compressed files usually take significantly less time to 
transmit.

Compact Pro also supports “archives”. An archive is a collection of files and 
folders which are combined into a single unit. By grouping related items into an 
archive, you can simplify the storage of large amounts of data. This helps organize 
your backup data storage in much the same way that using folders helps organize 
your desktop.

Features

• Advanced compression algorithm typically reduces file size by 50%.

• Files and folders may be stored together in “archives” which further reduce 
storage space and simplify file management.

• Encryption capability provides the ability to scramble sensitive data files so that 
a password is required to access them (North American version only).

• Automatic segmentation of archives makes it simple to build archives which are 
larger than a single disk.

• Optionally builds “self-extracting” archives.

• Supports file compression as a background job.
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Requirements/Limitations

To use Compact Pro, you must have a Macintosh 512KE or higher model (Plus, 
SE, SE/30, II, IIcx, etc.), and you must be running System file 4.2 or higher. 
Compact Pro requires 522K bytes of free memory to operate.

Compact Pro can store up to 1500 files and folders in an archive. Segmented 
archives are limited to 255 segment files.

How Does Data Compression Work?

Compact Pro “compresses” the data in a file by analyzing the data and then 
encoding it in a more efficient manner. The encoded data takes up much less space, 
but still contains all of the “information” in the original file. For example, if a 
document contained the character “A” repeated 20 times, most word processing 
programs would store this as 20 individual characters. By encoding the repeated 
characters as 20(A), only 5 characters are required. The resulting data is much 
smaller, but all of the original meaning is retained. By using a complementary 
decoding process, the original file can be later produced from the compressed file.
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__________________________________________________________________________

2 Getting Started
__________________________________________________________________________

Installing Compact Pro

Compact Pro is distributed as a single file called “Compact Pro Package” which is 
a self-extracting archive. When this file is opened from the Finder™, it creates a 
folder containing the Compact Pro application and supporting documentation.

The following files are included in the Compact Pro package:

Compact Pro—The Compact Pro application program
Compact Pro User’s Guide—User’s manual (this document)
Release Notes—Notes regarding the latest release
Registration Form—Registration form in TeachText™ format
Disk Order Form—Disk order form in TeachText format

To install Compact Pro, place a copy of the “Compact Pro” file in any folder on 
your startup disk (the one which has your System folder). If your startup disk does 
not have enough free space to hold the Compact Pro application, you may store it 
on ANY mounted disk, but some operations will not be as smooth.

Registering Your Copy

Compact Pro is distributed as Shareware. It is NOT free. You are permitted to use 
the product on a trial basis for up to 30 days. If you wish to continue using the 
product beyond that period, you are required to pay a registration fee of $25. For 
details on registering, see the chapter on “Distribution/Registration”.
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__________________________________________________________________________

3 Using Compact Pro
__________________________________________________________________________

About Archives

Compact Pro creates documents called archives. One archive can hold the data for 
many files and folders on your Macintosh. You may add files to an archive, 
eliminate files from an archive, or copy files from an archive to other folders on 
your Macintosh.

Archives provide a simple method of grouping related files to reduce clutter on the 
Macintosh desktop and your backup disks. Archives contain their own type of 
folder that is similar to the ones on the Macintosh’s desktop (you can move whole 
groups of files/folders from your desktop to an archive, or vice versa, in one 
operation).

Unlike the files/folders on the desktop, the names of files in an archive are not 
required to be unique; you may have two files with the same name, in the same 
folder. This allows you to save multiple versions of a changing document without 
having to change the name every time it’s saved.

Most archives consist of a single document which is represented by a file cabinet 
icon on the Macintosh desktop. You can move and copy an archive just like any 
other document. At times, you may want to make an archive which is too large to 
fit on a single disk. Compact Pro provides a simple means for making archives 
which span several disks. For more information on this type of archive, see the 
section titled “Working With Segmented Archives” later in this chapter.

Generally, you will use the Compact Pro application to save files in archives and 
read files from archives; however, Compact Pro also lets you build “self-
extracting” archives. A self-extracting archive has a tiny version of Compact Pro 
built in so that the archive can decompress its own contents. This feature is 
described in the section titled “Working With Self-Extracting Archives”.
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Viewing An Archive

When you open an archive, Compact Pro displays a catalog of the files and folders 
which are contained in the archive. The catalog is viewed as a series of folders, and 
the first folder displayed is the “top folder” of the archive. As you move from 
folder to folder, the catalog window shows information for the current folder. An 
example of a catalog window is given below. The name of the current folder is 
displayed in a box in the upper left corner of the window (the box is absent in the 
top folder).

In addition to the name of each file and folder, the catalog window displays each 
file’s type and creator code in the Type/Crea column. These are four-character 
names which applications attach to their files to indicate which application created 
a file and what type of information is in the file. For example, the third file (“ROI 
Analysis”) in the catalog window above was created by Microsoft® Excel as 
indicated by the XCEL creator code. The XLS_ type code indicates it is an Excel 
spreadsheet. While many of the creator codes are similar to the names of their 
applications, some (like the WILD code used by HyperCard® for the “Quotes 
Stack”) are not. Notice that folders do not have a type or creator code.

The Expanded column indicates the number of bytes a file will require if it is 
extracted from the archive to create a conventional file. The Compacted column 
indicates the number of bytes (including overhead) which the file consumes in the 
archive.
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The bottom line of the catalog window gives a summary of the displayed 
information. The file count and size totals include all files which reside in all 
folders contained in the current folder. When the top folder is displayed, these 
totals provide a summary of the entire archive.

Special Indicators

The icon at the beginning of each line indicates whether the item is a folder, an 
application or some other type of file. Sometimes an icon will be shaded like the 
one for the “Prime Report” file in the example catalog window. This indicates that 
you have marked this file to be added to the archive, but the file’s data has not yet 
been compressed and stored in the archive.

Sometimes an item will be marked with a ∑ like the one which appears next to the 
“Net Present Value” file. This marker indicates that the file is encrypted and a 
password will be required to access it.

A notepad icon in the upper left corner of the catalog window indicates that the 
archive has a note attached to it. You may view and modify the note by clicking on 
this icon.

Viewing Modes

The View menu lets you select the order in which the files are displayed in a folder. 
You may order the files by name (alphabetically), by size (from largest to 
smallest), by modification date (from newest to oldest), or by the order in which 
they were saved in the archive (earliest to most recent).

If you check Hide Type in the View menu, the Type/Crea field will not be 
displayed in the catalog window. This provides a simple way to view longer 
filenames on a Macintosh with a small screen.

Changing Folders

There are several ways to move between folders in the catalog window. You can 
move to a folder within the current folder by double-clicking on the desired 
folder’s name. As an alternative, you can select the folder by clicking on its name 
and pressing the Return or Enter key. If your Macintosh has arrow keys, you can 
use them to move the selection bar to the desired folder. Pressing the Down-Arrow 
key while holding down the Command key will move to the selected folder.
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To move up to one of the folders which contain the current folder, click on the 
name of the current folder (the box in the upper left corner). A pop-up menu will 
appear to let you select the desired folder. You can also move to the next higher 
folder by pressing the Up-Arrow key while holding down the Command key.

Selecting Multiple Files

Sometimes you will want to select more than one file or folder in the catalog 
window. This is accomplished using the Shift and Command modifier keys in 
conjunction with the mouse. If you hold down the Shift key when selecting files, 
all entries between the last selection and the current mouse position will be 
selected. If you hold down the Command key when selecting files, any file clicked 
will be changed from its current state—selected files will be deselected and 
unselected files will be selected.

Creating And Opening Archives

Creating a new archive is simple. Select the New command from the File menu and 
an empty catalog window will appear. After you have added the files you want in 
the archive (see “Adding New Files To An Archive”), use the Save or Save As 
commands to save your work. Until then, the catalog window will remain 
“Untitled”. Like most Macintosh applications, no file is actually created until you 
save your work.

Open an existing archive by selecting the Open command from the File menu. A 
dialog box will appear to let you choose the archive you wish to open.
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Modifying An Archive

Once an archive has been opened, you can create folders in it and add new files. 
You can also change the names of existing files or remove them. In addition, 
Compact Pro provides the ability to attach a descriptive note to the archive for 
future reference.

Adding New Files To An Archive

To add new files to an archive, select the Add command from the Archive menu. 
This will display the Add dialog box (above) which lets you select a file or folder 
to add to the archive. If you select a folder, all the files and folders contained in that 
folder will be added to the archive. Since any file/folder you add is inserted in the 
current folder of the archive, it’s important to move to the desired destination folder 
BEFORE you select the Add command.

[Tip: If you want to add most of the files in a folder, but not all of them, it may be 
quicker to add the entire folder and then use the Clear command to eliminate the 
ones you don’t want.]

The Add dialog box provides several options when adding files. If you check the 
Add only if modified on/after: date checkbox, Compact Pro will only add a file 
from the group you’ve specified if the file was last modified on or after the date 
specified. This provides a simple means for performing incremental backups. You 
can specify the date of your last backup and only add the files that have changed 
since then. If you are updating an existing archive, Compact Pro automatically sets 
this date to the last date the archive was modified.
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By checking the Delete original after saving checkbox before adding files, you 
can have Compact Pro automatically delete the files from your desktop after 
they’ve been saved in the archive. This is useful when you want to move files from 
your desktop into an archive without keeping the original copies.

Note: To have the desired effect, the checkboxes in the Add dialog box must be set 
BEFORE you click the Add button.

Creating New Folders

If you want to create folders in the archive which do not already exist on the 
desktop, you can create new, empty folders using the New Folder command in the 
Archive menu.

Changing The Names Of Existing Files

You can change the name of a file or folder which already exists in an archive by 
selecting the entry and using the Change Name command in the Archive menu. 
You cannot change the name of a file/folder which has not been stored into the 
archive yet. The icons for these entries are shaded in the catalog window.

Removing Old Files From An Archive

Existing files and folders may be removed from an archive by selecting them and 
pressing the Delete key or using the Clear command in the Edit menu.
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Adding A Note

If you work with many archives, it may be convenient to attach notes to them to 
indicate what they contain or when they were generated. The Note command in the 
Archive menu provides a way of attaching a memo up to 254 characters long. Once 
a note is attached, a notepad icon will be displayed in the upper left corner of the 
catalog window. You may view and edit the note by clicking on this icon.

Saving Your Work

After you’ve added new files to an archive, deleted old files, or made other 
changes, you must “save” the archive to make the changes permanent.

If you are working with an existing archive, you will normally choose the Save 
command from the File menu to update the archive with the changes you’ve 
specified. If you would rather create a new archive, use the Save As command 
instead. This will copy any necessary files from the old archive to the new archive. 
Any changes specified will affect only the new archive.

If you are working with a new (untitled) archive, you may use either the Save or 
Save As commands in the File menu. Both commands bring up the Save As dialog 
box which lets you name the new archive.

In addition to letting you select the name for a new archive, the Save As dialog box 
also includes a Self-Extracting checkbox. Checking this checkbox includes a 
small self-extracting application in the new archive. For more information on this 
feature, see the section titled “Working With Self-Extracting Archives”.

Background Operation

It is during the process of saving an archive that Compact Pro compresses the data 
in any newly added files. This can take a long time due to the large number of 
computations required. If you are using System 7 (or System 6 and MultiFinder™), 
you can switch to another application and Compact Pro will continue working in 
the background. The status window will disappear when the compacting is 
complete. If an error occurs, Compact Pro will flash its file cabinet icon on top of 
the apple icon in the menu bar.
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Storing Small Files

As you use Compact Pro, you may notice that small files (shorter than 200 bytes) 
usually become LARGER when they are placed in an archive. This is due to the 
extra information which Compact Pro must keep to remember the file’s name, size, 
etc. Surprisingly, even when Compact Pro shows an increase in a file’s size, you 
will typically still save space by storing the file in an archive. Due to the overhead 
of the Macintosh file system, even the smallest file requires a minimum of 1024 
bytes on a Macintosh disk. Since these files use much less than 1024 bytes in an 
archive, an overall savings may be realized. As an example, twenty 100-byte files 
would require 20,480 bytes (20 x 1024) if stored as conventional files. If each file 
required 150 bytes in an archive, the total space required by the archive would be 
3,072 bytes—a savings of 85%.

Retrieving Files From An Archive

When you want to use a file which is stored in an archive, you must re-create the 
original file by ”extracting” it from the archive. To extract a file, select a filename 
in the catalog window and use the Extract command in the Archive menu. The 
dialog box below is displayed to let you select the folder where the copy will be 
created.

You may select groups of files and folders in the catalog to be extracted in one 
operation by using the Command and Shift keys (see “Selecting Multiple Files”). 
When you select a folder, Compact Pro will not only extract all of the files in the 
folder, it will also extract any folders contained within that selected folder. The 
hierarchy of folders in the archive will be re-created in the destination folder you 
specify in the extract dialog box. Compact Pro will create any new folders which 
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are required.
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[Tip: You may extract a single file by double-clicking on its name. Likewise, a 
group of files and folders may be extracted by selecting them and then double-
clicking on one of the selected items.]

There are two options in the Extracting Preferences which affect the way Compact 
Pro extracts files. The first one specifies how Compact Pro should handle a request 
to extract a file which already exists in the destination folder. The second 
determines the “last modification date” which is assigned to an extracted file. For 
more information on these options, see the section on “Setting Preferences”.

Desktop Expanding

Compact Pro supports a shortcut called “Desktop Expanding” which lets you 
rapidly extract all the files in an archive. When working in the Finder, you can 
“expand” an archive by holding the Option key while double-clicking on the 
archive’s icon (you may have to hold the Option key until the Compact Pro status 
window appears). Compact Pro will extract all the files in the archive and place 
them in a new folder. The new folder has the same name as the archive with an ‘ƒ’ 
appended (“.cpt” and “.sit” extensions are removed if present). As an alternative, an 
option in the Desktop Expanding Preferences lets you store all extracted files in the 
same folder as the original archive and skip creating the new folder.

After all the files have been extracted from the archive, Compact Pro will ask if 
you wish to keep or delete the original archive. You may change the Desktop 
Expanding Preferences so that the archive is AUTOMATICALLY kept or deleted if 
you prefer.

You can expand several archives at once by selecting the desired archives in the 
Finder and then double-clicking one of them while holding the Option key. Note: 
If Compact Pro is already running, only one archive will be expanded.
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You can use the Desktop Expand feature from inside Compact Pro as well. To 
expand an archive, use the Open command in the File menu. Select the archive but 
hold the Option key when you click the Open button in the Open dialog box. All 
of the archive’s files will be extracted into a folder as described above.

Note: Holding the Option and Command keys while pressing the O key does 
NOT work as a keyboard equivalent to start a desktop expand.

Note: If you use the Desktop Expanding feature and you don’t have a copy of the 
Compact Pro application on your startup volume, the system may try to “switch-
launch” to the disk containing the Compact Pro application. This will produce an 
error message such as “The volume ‘ABC’ could not be made the startup volume 
…”. You can safely ignore this message—just continue to hold the Option key and 
click the OK button to proceed.

Background Operation

While extracting is not as slow as compacting, there are many calculations 
involved in rebuilding a compacted file. If you are extracting a large number of 
files, or a few large files, the process can be quite lengthy. If you are using System 
7 (or System 6 and MultiFinder), you can switch to another application and 
Compact Pro will continue extracting in the background. The Compact Pro status 
window will disappear when all files have been extracted. If an error occurs, 
Compact Pro will flash its file cabinet icon on top of the apple icon in the menu 
bar.
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Validating Files In Archives

There may be times when you will want to verify that the data in an archive is still 
valid. This might happen if some of the files on an archive disk have been 
damaged. You might also want to verify that files have been stored properly when 
you have archived files that are especially valuable to you.

Before a file is compressed, Compact Pro generates a check code for the data in the 
file (a 32-bit Cyclic Redundancy Code is used). When the file is extracted, 
Compact Pro generates the check code for the resulting file. By comparing these 
codes, it can determine—with a fairly high degree of certainty—if the file has been 
reconstructed properly.

One way to verify the files in an archive, therefore, is to extract them. If no errors 
are reported, there is a high probability that the files have been recovered properly.

A more convenient way to verify the files in an archive is to use the Validate 
command in the Archive menu. This command works just like the Extract 
command and performs the same decompression process except that it does not 
store the results on disk. This lets you verify the files in an archive without 
modifying any of the files or folders on your Macintosh. If you check the Validate 
archive after Save option in the Compacting Preferences, Compact Pro will 
automatically validate all the files in an archive whenever changes to the archive 
are saved.

Encrypting Files

Note: Due to export regulations of the US government, encryption capabilities are 
only enabled for copies of Compact Pro which are registered to residents of the US  
and Canada. Encryption is not available in unregistered copies.

Compact Pro provides a way for you to prevent unauthorized access to the files you 
store in an archive. Files can be “encrypted” with a password of your choice—this 
makes them unreadable by anyone else. When you expand an encrypted file, you 
must specify the same password which was used to encrypt it initially. No portion 
of an encrypted file can be extracted without the proper password.

To encrypt a file, you must check the Encrypt checkbox in the Add dialog box 
before you add the file to the archive. The entry for that file in the catalog window 
will be marked with a ∑ to indicate that it is encrypted. [Tip: If you want to change 
the Encrypt flag for a file which has been added to an archive but not yet saved, 
you can use the Get Info command in the Archive menu to change its value. Once 
the file is saved, no further changes can be made.]
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When you save the archive, Compact Pro will ask you to specify a password to be 
used for the encrypted files. This password must contain at least one character and 
no more than 99. Your files are most secure when you use longer passwords. Non-
printing characters are permitted in the password, but you may find it difficult to 
remember your password if you use too many unusual characters.

The Set Password command in the Misc menu lets you specify a password before 
Compact Pro asks for it. However, the password is not actually used until the 
archive is saved, so all of the newly added files will be encrypted with the last 
password specified. Changing the password BEFORE you add each file will NOT 
assign different passwords to each file. If you want files to be encrypted with 
different passwords, you must save the archive after each file is added.

When you extract an encrypted file from the archive, Compact Pro will ask you to 
specify the password. This same password will be used for all files extracted in one 
operation; you will not be asked for a password for each encrypted file. If you are 
extracting files which have different passwords, you must use the Set Password 
command to change the password between extract operations.

Warning: The encryption algorithm used by Compact Pro is quite secure and does 
not contain any “back doors” which would allow access to an encrypted file 
without knowing the password. As a result, you must be careful to remember the 
passwords for your encrypted files since there is no known way to recover your 
files without them.
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Working With Segmented Archives

Compact Pro can build “segmented archives”. A segmented archive is a single 
archive which is divided into several pieces called “segments” (a segmented 
archive may have as many as 255 segments). Each segment is an ordinary 
Macintosh file and has the same icon as any other Compact Pro archive.

There are several reasons you might want to build a segmented archive. Suppose 
you have compacted a group of files to send to a friend, but the archive is too large 
to fit on one floppy disk. By creating a segmented archive, you could break the 
original archive into several smaller “segment files” and place each one on a 
separate floppy disk.

Segmented archives may also be useful when transferring large archives using 
datacommunications services. Some services are prone to errors which may result 
in a transferred file being damaged. The probability of an error occurring is often 
proportional to the length of the file—the longer the file, the more likely an error 
will occur during the transfer. By sending several shorter files, you may be able to 
transfer an archive which you could never transfer in one piece.

Creating A Segmented Archive

There are two basic ways to create a segmented archive—automatically and 
manually.
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Compact Pro automatically creates a segmented archive if you run out of room 
while updating or creating an archive with the Save or Save As commands. If the 
destination disk becomes full, Compact Pro ejects the disk and asks you to specify 
the name for an additional segment file. Typically, you just insert another floppy 
disk and specify a new filename. It is not necessary for the new disk to be empty. If 
it contains other files, Compact Pro will use whatever space is available. Note that 
if you insert an unformatted disk, Compact Pro will initialize it for you.

You can manually divide an existing archive into segments using the Segment 
command in the Misc menu. Manual segmenting gives you the option of creating 
segments of a pre-determined size rather than simply filling a disk. To manually 
segment an archive, open the archive with the Open command then select the 
Segment command in the Misc menu. A dialog will be displayed which allows you 
to specify the size for the segments (one option is As Large As Possible which fills 
the disk in the same manner as automatic segmenting). Next, Compact Pro prompts 
you to name each segment as it creates the segment files.

Note: Compact Pro tries to limit each segment to the requested size, but the first 
and last segments of an archive may be larger if a small segment size is specified.
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Naming Segment Files

Segment files may be moved from one disk or folder to another and may be named 
in any manner you wish. The names of the files are not important since Compact 
Pro saves information inside the files to determine their proper ordering. The 
locations are not important either since Compact Pro will ask YOU to find a 
segment file when it’s needed. However, it is generally easier to work with 
segmented archives if you use Compact Pro’s default naming convention.

When Compact Pro suggests a name for a segment, it always starts with a basic 
archive name, optionally appends “.cpt” or “.sea”, and then appends the segment 
number. For example, if the Add .cpt/.sea extension to new archive names 
preference is enabled and you segment an archive named “MyArchive”, Compact 
Pro will recommend the name “MyArchive.cpt.#1” for the first segment.

Accessing Files In A Segmented Archive

Aside from desktop expanding—which only works on single-segment archives—
you may perform any operation on a segmented archive which is allowed on a non-
segmented archive. The only difference is that you must open the FINAL segment 
of a segmented archive in order to access its contents. When you do something 
which requires the data from another segment in an archive, Compact Pro will 
display a dialog box prompting you to “load” the segment file. You should select 
the name of the requested segment file, and click the Load button (you may have 
to eject one disk and insert another to find the required segment file).

Updating Segmented Archives

When you add or remove files from a segmented archive, Compact Pro tries to 
pack the data as efficiently as possible in the final segment, but it will never go 
back and add or remove files in earlier segments. This restriction is necessary to 
ensure the integrity of the archive under some error conditions.

If you have removed files from earlier segments in a segmented archive, you can 
shrink the total size of the archive by creating a copy (Compact Pro will discard the 
removed files during the copying process). You can make a copy of an archive by 
opening it and then using the Save As command.
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Working With Self-Extracting Archives

Compact Pro has the ability to build “self-extracting” archives. A self-extracting 
archive has a small, built-in application which can extract the files from the archive 
without Compact Pro being present. When you open or double-click a self-
extracting archive from the Finder, the embedded application (called 
AutoExtractor™) decompresses all the files in the archive just as if you selected all 
the files in the archive and performed an Extract command in Compact Pro. 
AutoExtractor will prompt you for a destination folder and then extract all files and 
folders in the archive. If the archive contains encrypted files, you will be asked to 
supply a password.

Self-extracting archives are useful when you want to give an archive to someone 
who does not have a copy of the Compact Pro application. Rather than sending a 
copy of the entire “Compact Pro Package”, you can send an archive with the 
extracter built in.

Self-extracting archives will work with any Macintosh model except the 128K and 
512K (these models may be used if the HD20 INIT is installed to provide the 
Hierarchical File System). The extracting computer must be running System File 
3.2 or higher, and it must have 313K bytes of free memory available.

Making A Self-Extracting Archive

To make a self-extracting archive, use the Save As command from the File menu. 
When the Save As dialog box appears, check the Self-Extracting checkbox. The 
new archive will include the AutoExtractor application which adds approximately 
13K bytes to the size of the archive. The archive will also have a different icon to 
distinguish it from a normal archive.

Note that once an archive has been created, you cannot change it from normal to 
self-extracting or vice versa; however, you can always make a new copy using the 
Save As command. You may add or remove files from a self-extracting archive 
using the same commands you would use for a normal archive. The only difference 
is that you must use the Open command from the File menu to access the archive 
since double-clicking on a self-extracting archive will launch the built-in 
AutoExtractor application instead of Compact Pro.
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If you use the Note command to add an archive note to a self-extracting archive, 
the note will be displayed each time the self-extracting archive is launched.

Working With StuffIt Archives

Compact Pro can open and extract files from archives created by StuffIt™ 1.5.1. 
Use the Open command from the File menu to open a StuffIt 1.5.1 archive. Once 
open, you may view the catalog and extract files using the same commands you 
would use with a Compact Pro archive. Note that Compact Pro cannot extract 
encrypted files from StuffIt 1.5.1 archives, and it cannot extract files from archives 
created by StuffIt Deluxe™.

Working With BinHex4 Files

BinHex4 is a file format used by some communications networks (Usenet, for 
example) to encode non-text Macintosh files so that they may be transmitted and 
stored as text files. It is not compatible with the BinHex5 format which is more 
widely known as “MacBinary”. Compact Pro can encode standard Macintosh files 
using the BinHex4 format, and it can decode files which are encoded using the 
BinHex4 format.

To convert a Macintosh file to BinHex4 format, use the Convert TO BinHex4 
command in the Misc menu. Compact Pro asks you to select the file to be 
converted and then asks you to supply a name for the file to be created (the source 
file is left unmodified). If the Include LFs checkbox is checked, Compact Pro adds 
Line Feed characters at the end of each line of text in the BinHex4 file (this is 
required by some systems); otherwise, it omits them to reduce the file size. The 
default creator code for BinHex4 files may be specified in the Miscellaneous 
Preferences.

To convert a BinHex4 format file back to a normal Macintosh file, use the Convert 
FROM BinHex4 command in the Misc menu. Compact Pro asks you to select the 
BinHex4 file to be converted and then asks you to supply a name for the file to be 
created (the source file is left unmodified). Note: By default, Compact Pro will 
only allow you to convert files of type 'TEXT'. If you hold the Option key when 
you select Convert FROM BinHex4, Compact Pro will allow you to convert files 
of any type.
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Printing The Catalog

Use the Print command in the File menu to print the catalog of an archive on a 
printer. The document produced is similar to the display in the catalog window 
except that ALL of the files in the archive are displayed rather than just the ones in 
the current folder.

The File menu also contains a standard Page Setup command which lets you set 
the page size and other options before you print.

Generating A Report File

Use the Report command in the File menu to generate a text file which has a list of 
all the files and folders in an archive. Each line contains a file/folder name, type 
code, creator code, expanded file size, compacted file size, percentage reduction 
and last modification date. The fields are separated with tab characters. A checkbox 
in the Report dialog lets you omit the header and total lines which are normally 
included in the file. The default creator code for report files may be specified in the 
Miscellaneous Preferences.

25



Compact Pro User's Guide

Setting Preferences

The Preferences command in the Misc menu displays four dialog boxes which let 
you tailor Compact Pro’s operation to your work style.

Add .cpt/.sea extension to new archive names
If this box is checked, Compact Pro adds either “.cpt” (standard archives) or “.sea” 
(self-extracting archives) to the initial filenames suggested for archives during Save 
operations.

Make new archives self-extracting by default
If this box is checked, new archives are self-extracting by default.

Fast Save (no compression)
Selecting this option speeds up Save operations by not attempting to compress the 
data in files. File data is copied to the archive with a simple compression algorithm 
which typically produces no reduction in size.

Validate archive after Save
If this box is checked, Compact Pro validates all files in an archive after every Save 
operation.

Skip busy files without asking
If this option is not enabled, Compact Pro will stop and display a message 
whenever a newly added file is found to be busy during compacting. If this option 
is enabled, it will automatically skip any busy files.
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Set date of extracted file to:
These buttons determine the “last modification date” assigned when a file is 
extracted. If Date saved with file is selected, Compact Pro uses the date stored in 
the archive (the last date when the file in the archive was actually modified). If 
Current date is selected, Compact Pro uses the current date (the date when the file 
was extracted).

When extracting a file with the same name as an existing file:
These buttons specify the action Compact Pro should take when a file being 
extracted already exists in the destination folder you’ve specified. If Ask before 
replacing existing file is selected, Compact Pro displays a dialog to let you decide 
whether to replace the existing file or keep it. If Replace existing file without 
asking is selected, Compact Pro always deletes the existing file and replaces it with 
the new file extracted from the archive. If Never replace existing file (skip) is 
selected, Compact Pro skips any files which already exist.
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When expanding an archive from the desktop, put extracted files in:
These buttons determine where extracted files are stored when an archive is 
expanded on the desktop. If A new folder is selected, Compact Pro creates a new 
folder and stores the files there. The new folder has the same name as the archive 
with an ‘ƒ’ appended (“.cpt” and “.sit” extensions are removed if present). If The 
same folder as archive is selected, Compact Pro stores the files in the folder which 
holds the archive.

After expanding an archive from the desktop:
These buttons determine what Compact Pro does with an archive after it has been 
successfully expanded on the desktop. If Delete archive is selected, Compact Pro 
removes the archive. If Keep archive is selected, it leaves the archive in place. If 
Ask is selected, Compact Pro displays a dialog to let you decide what to do.
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Beep when operation is complete
If this option is selected, Compact Pro beeps when a Save, Save As, Extract, or 
Validate operation finishes.

Remember window positions between sessions
If this box is checked, Compact Pro saves the positions of the catalog and status 
windows when you quit. When you start again, the windows will be restored to 
their most recent positions. If you always want the windows to start in the same 
positions, you should uncheck this checkbox. [Tip: You may want to check this 
box for the first several times you run Compact Pro until you get the windows 
positioned where you like them. After that, uncheck the box to retain those window 
positions permanently.]

Ask before removing file or folder from archive
Checking this box makes a confirming dialog appear every time you try to delete a 
file or folder.

Creator code for text files
These four characters define the creator code assigned to the report and BinHex4 
text files created by Compact Pro. The standard value is “ttxt” which is the creator 
code for the TeachText application.
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__________________________________________________________________________

4 Technical Support
__________________________________________________________________________

You may send questions, problem reports, suggestions for improvements and 
general comments about Compact Pro to:

Cyclos
PO Box 31417
San Francisco, CA  94131-0417
USA

 You may also contact the author by electronic mail:

CompuServe: 71101,204
Internet: 71101.204@compuserve.com

Answers To Some Common Questions

Q: Why does the compacted size column on the total line show a number larger 
than 0 for an archive or folder which contains no files?

A: The compacted size column indicates the total space required in the archive 
including the internal overhead Compact Pro requires to keep track of filenames, 
etc.

Q: Copying one multi-segment archive (on floppies) to another requires a lot of 
disk swapping on a single floppy system. Is there an easier way to do this?

A: If you have a hard disk with enough space to hold the entire archive, it is much 
quicker to make the copy in two steps. First, open the original multi-segment 
archive with Compact Pro and use the Save As command to make a copy on the 
hard disk. This will be a single segment archive. Next, open the archive on the hard 
disk and use the Save As command again to make the new multi-segment archive.
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Q: Why does Compact Pro keep asking me to insert disks after I have cancelled a 
Save operation?

A: When you are creating a multi-segment archive and you cancel the operation or 
an unrecoverable error occurs, Compact Pro asks you to re-insert all the other disks 
so that it can remove the files which no longer contain valid information.

Q: It seems like the Delete original after saving option in the Add dialog box only 
works some of the time. What’s wrong?

A: For a file to be deleted, the Delete original after saving checkbox must be 
checked BEFORE you add the file.

Q: When I have GateKeeper™ (the virus protection program) enabled, it 
occasionally complains that Compact Pro is trying to violate “File(Other)” 
privileges against a file I’m extracting. Does this mean I have a virus?

A: Probably not. When Compact Pro extracts a file, it must perform some 
operations which look similar to the operations performed by some viruses. 
GateKeeper is warning you that these operations look suspicious. You can 
eliminate these warnings by adding Compact Pro to GateKeeper’s list of known 
applications and checking the “File(Other)” checkbox.

Q: I installed CptExpand™ and Compact Pro on the same disk. Now the icons for 
CptExpand and Compact Pro seem to get mixed up. Sometimes Compact Pro 
launches when I double-click on an archive to open it, and sometimes CptExpand 
starts. What’s wrong?

A: CptExpand and Compact Pro cannot co-exist on the same disk. You may install 
one or the other but not both. If you have installed both on the same system or you 
are removing one and installing the other, you can clear up any launch problems by 
deleting all copies of the application you no longer want. To ensure that the proper 
icons are displayed, use one of the following procedures:

1) The simplest solution is to rebuild the Finder’s desktop file. It’s not a bad idea to 
rebuild the Finder’s desktop file every once in a while since this speeds up some 
Finder operations; however, rebuilding the desktop file will permanently erase any 
notes you’ve attached to files in the Finder’s “Get Info” boxes. Warning: DON’T 
REBUILD THE DESKTOP FILE IF YOU WANT TO KEEP THESE FINDER 
NOTES. To rebuild the desktop file on a hard disk, restart your Macintosh and hold 
down the Option and Command keys while it starts up. When a dialog appears 

31



Compact Pro User's Guide

asking if you want to rebuild the desktop, click OK. You can rebuild the desktop 
on a floppy disk by pressing the Option and Command keys while you insert the 
disk.
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2) If you don’t want to lose the Finder notes you’ve attached, use this procedure 
instead: First, copy the desired application to a blank floppy disk. Rebuild the 
desktop on this floppy disk by unmounting it (drag the disk icon to the trash) and 
then re-inserting it while holding down the Option and Command keys. Next, 
copy the application back to the desired destination disk. Finally, restart your 
Macintosh.
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__________________________________________________________________________

5 Distribution/Registration
__________________________________________________________________________

What Is Shareware?

“Shareware” is a method of software distribution which gives users a chance to try 
software before buying it. If you try a Shareware program and continue using it, 
you are expected to register. Details vary for individual programs—some request 
registration while others require it; some specify a maximum trial period. With 
registration, you get anything from the simple right to continue using the software, 
to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the 
copyright holder retains all rights with a few specific exceptions as stated below. 
Like commercial authors, Shareware authors are accomplished programmers, and 
the programs are of comparable quality (in both cases, there are good programs and 
bad ones). The main difference is in the method of distribution. The Shareware 
author specifically grants the right to copy and distribute the software, either to all 
and sundry or to a specific group. For example, some authors require written 
permission before a commercial disk vendor may copy their software.

Shareware is a distribution method, not a type of software. You should find 
software that suits your needs and pocketbook—whether it’s commercial or 
Shareware. The Shareware system makes fitting your needs easier because you can 
try before you buy. Furthermore, since the Shareware author’s overhead is low, 
prices are generally low as well. Shareware has the ultimate money-back guarantee
—if you don’t use the product, you don’t pay for it.
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Distribution

Compact Pro is a Shareware program and is provided at no charge to the user for 
evaluation. You are encouraged to copy and distribute Compact Pro for non-
commercial use with the following restrictions:

• You may copy and distribute the self-extracting “Compact Pro Package” file but 
not the individual application and document files. This ensures that users receive 
a complete package with all documentation files.

• You may not modify the “Compact Pro Package” file in any way.

• You may not charge any fee for the use, copying, or distribution of the product.

Commercial Distribution Of Compact Pro

Clubs and user groups may charge a nominal fee (not to exceed $10) for expenses 
while distributing Compact Pro. All other organizations must obtain written 
permission to distribute copies of Compact Pro if any fee is charged for the use, 
copying, or distribution of the product.

Commercial Distribution Of Archives Created By Compact Pro

Standard and self-extracting archives created by Compact Pro may be used for 
commercial distribution with no additional license fee. Note that self-extracting 
archives contain an embedded application named AutoExtractor™ which is 
copyrighted. Any modification of AutoExtractor’s code or associated resources 
(including icons) is strictly prohibited.
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Registration

If you find Compact Pro useful and continue to use it beyond the 30 day free trial 
period, you are required to register your copy.

Single-Machine Licensing

A $25 registration fee will license one copy of Compact Pro for use on any one 
computer at any one time. For example, one copy may be used by any number of 
people and may be freely moved from one computer to another as long as there is 
no possibility of it being used simultaneously on more than one machine.

To register your copy of Compact Pro, print the “Registration Form” file and fill it 
out. If you do not have a means of printing the form, write your name, address and 
“Compact Pro 1.32” on a blank sheet of paper. Mail the registration form with 
payment of the $25 license fee to:

Cyclos
PO Box 31417
San Francisco, CA  94131-0417
USA

Note: California residents must add applicable sales tax.

Quick Tip: If you are registering a single copy of Compact Pro and paying with a 
check which is imprinted with your name and address, it is not necessary to use the 
registration form. You may register by writing “Compact Pro 1.32” on the check 
and mailing it to the address above.

When you register, you will receive a registration code which can be used to 
personalize your copy of Compact Pro. Once your registration code has been 
entered, the registration reminder screen will no longer be displayed. Your name 
will appear in the “About Compact Pro” dialog box and on the printed reports.
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Site Licensing

Site licenses are available to permit the use of Compact Pro within companies or 
government agencies. A site license allows internal use and copying for a specified 
number of computers.

The fee for a site license is $20 for each computer covered. The minimum license 
fee is $200 which includes licensing for the first 10 computers. Additional 
discounts may be negotiated if a large number of machines is licensed. California 
companies must add applicable sales tax.

To request a site license, send a letter specifying your organization’s name and 
address—as they should appear on the site license contract—and indicate the 
number of computers you wish to have covered by the license. You will receive 
two copies of the site license which must be signed and returned with payment of 
the site license fee. An authorized copy of the site license will be mailed to you 
along with a registration code to be used on all the machines you have licensed.

Program Updates

Registered users of Compact Pro are entitled to use future versions of Compact Pro 
without paying any additional licensing fee. In general, users will not be notified 
directly of new releases, so it is a good idea to check electronic bulletin boards, 
users groups or magazines for announcements of new versions.

Typically, new releases are available on most of the national information services 
(America On Line, AppleLink, CompuServe, GEnie and Internet archive sites). If 
you have a modem, this is usually the simplest and least expensive way to obtain 
updates.

If you do not have a modem, check with your local Macintosh users group. Many 
users groups distribute disks containing the latest version of Compact Pro (and 
other Shareware programs) for a small fee.

If you prefer to have a disk mailed to you directly, you may use the disk order form 
provided in the Compact Pro Package to order an update disk.
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Warranty

Compact Pro is supplied as is. Cyclos hereby disclaims all warranties relating to 
this software, whether express or implied, including without limitation any implied 
warranties of merchantability or fitness for a particular purpose. Cyclos will not be 
liable for any special, incidental, consequential, indirect or similar damages due to 
loss of data or any other reason, even if Cyclos, or an agent of Cyclos has been 
advised of the possibility of such damages. In no event shall Cyclos’ liability for 
any damages ever exceed the price paid for the license to use the software, 
regardless of the form of the claim. The person using the software bears all risk as 
to the quality and performance of the software.

38


